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Formulas & Functions Fundamentals 
 
The following definitions are necessary to understand the basics of creating Excel 
formulas and functions. 
 
Formula Definition 
 A formula allows you to calculate and analyze data in your worksheet. Formulas perform 
calculations such as addition or multiplication; formulas can also combine values.  
 
Formula Syntax 
 Formula syntax is the structure or order of the formula elements. All formulas begin with 
an equal sign (=) in Excel followed by operands (the data to be calculated) and the 
operators. Operands can be values that don’t change (constants), a range reference, a 
label, a name, or a worksheet function. 
 
Formula Bar 
The formula bar is an area located at the top of the worksheet window that is used to 
enter or edit values or formulas in cells or charts. The formula bar displays the constant 
value or formula in the active cell. To display or hide the formula bar; click Formula 
Bar on the View menu.  
 

 
 

Function Definition 
A function in Excel is a built- in formula that performs a mathematical operation or 
returns information specified by the formula. As with every formula created in Excel, 
each function starts with an equal (=) sign. 
 
Function Syntax 
The syntax of a function begins with the function name, followed by an opening 
parenthesis, the arguments for the function separated by commas, and a closing 
parenthesis. If the function starts a formula, an equal sign (=) displays before the function 
name. 
 
Example: =SUM (D2:F8) 
In the above example, the function name is “SUM” and the argument for the function is 
the range “D2:F8”. 
 
Arguments 
An argument is the reference behind the function. The reference can be any of the 
following type: 
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Argument Types 

Argument Example 

Numbers 1,2,3 
Text "January" 

Logical Values (True or False) 
Cell References B7 or B7:B20 

 
 
Operators 
Operators are mathematical symbols that are broken into four categories 
 
 

Keystroke Operators 
Arithmetic Explanation Example 

+ Addition 2+3 

- Subtraction  5-1 

* Multiplication 7*3 

/ Division 7/2  

% Percent 90% 

^ Exponentiation 7^2 
Comparison Explanation Example 

= Equal to B1=D1 
> Greater than B1>D1 
< Less than B1<D1 

>= Greater than or equal to B1>=D1 
<= Less than or equal to B1<=D1 
<> Not equal to  B1<>D1 

Text Explanation Example 

& 
Adjoins text or cell references "Scott" & "Hi" 

produces  
"Scott Hi" 

Reference Explanation Example 

: 

Includes cells of a column or 
row between the designated 

limits B3 : B20 

, 
Separates arguments in a 
function (B3, B20) 

 
Operator Order 
Formulas are calculated left to right, using order of precedence, the parentheses have high 
order of precedence, i.e.: every thing inside them is eva luated first. 
Excel performs operations in the order shown in the following table. 
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Excel's Operator Order 

Arithmetic Operator Precedence Example 
1 % Percent 
2  ̂ Exponentiation 
3 *, / Multiplication, Division 
4 + , - Addition, Subtraction 
5 & Ampersand 
6 >,>=,<,<=,=,<> Comparisons 

 
Notice that percent has the highest precedence, multiplication and division have same 
order of precedence, also addition and subtraction have same order of precedence. 
Excel performs all operations within sets of parentheses first, and you can use this to get 
exactly the order of operations you want. If multiple operations are encased in multiple 
sets of parentheses, the operations are performed from inside to outside, then follow the 
order of operations, and then left to right. 
 

Function Wizard  
The function wizard is designed to help provide the necessary arguments and descriptions 
for the various Excel functions.  
 
 1. Select the cell in which you want the results of the function to display. 
 2. Click the Insert Function button  on the Standard toolbar or select Function from   
    the Insert menu. 
 3. From the Insert Function dialog box, browse through the functions by selecting a 
     Function category from the drop-down menu, and select the function from the 
     Function choices below. As each function name is highlighted a description and  
     example of use is provided below the two boxes. 
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3. Click OK to select a function 
4. The next window allows you to choose the cells that contain the arguments of the 
function. In the example below, cell B2 and C2 were automatically selected for the sum 
function by Excel. The cell values {2, 3} are located to the right of the Number 1 field 
where the cell addresses are listed. If another set of cells, such as B5 and C5, needed to 
be added to the function, those cells would be added in the format “B5:C5” to the 
Number 2 field. 
 

 
 

5. Click the OK button when all the cells for the function have been selected. 
 
 
 
 
Writing Multiple Copies of A Formula 
Two methods are used to create copies of your formula quickly. One method uses 
AutoFill to copy a formula to several more cells (refer to Excel-I tutorial).Another 
method creates multiple copies when you enter the formula. 
 
Entering Multiple Formulas All At Once 
 
To enter the same formula in several cells at once, follow these steps: 
 
1. Select all the cells you want to enter the formula in . 
2. Create your formula by whatever means you normally use, but don’t press Enter when    
  finished.  
3. When the formula is complete, press Ctrl+Enter. The formula is entered in all the 
selected cells simultaneously. 
 
 
Editing & Deleting Formulas 
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 You can also edit or delete any formula. To delete a formula, simply click on the cell 
  that contains the formula, and press the Delete key on your keyboard. If you find you  
  just need to alter the formula, do the following: 
 
   1) Click on the cell that contains the formula. 
   2) Click on the Formula Bar and make changes to your function. 
 
    If the formula uses a built- in Excel function: 
   1) Click on the cell that contains the function to select it 
   2) Click on the Insert Function  button on the formula bar to edit the arguments. 
       Change the appropriate argument(s) and click OK. 
 
Absolute References  
Calling cells by just their column and row labels (such as "A1") is called relative 
referencing. When a formula contains relative referencing and it is copied from one cell 
to another, Excel does not create an exact copy of the formula. It will change cell 
addresses relative to the row and column they are moved to. For example, if a simple 
addition formula in cell C1 "=(A1+B1)" is copied to cell C2, the formula would change 
to "=(A2+B2)" to reflect the new row.  
 
Relative References  
 To prevent the previous change, cells must be called by absolute referencing and this is 
accomplished by placing dollar signs "$" within the cell addresses in the formula. 
Continuing the previous example, the formula in cell C1 would read "=($A$1+$B$1)" if 
the value of cell C2 should be the sum of cells A1 and B1. Both the column and row of 
both cells are absolute and will not change when copied, so  
C2 would also read "=($A$1+$B$1)". 
You can also specify one label to be absolute, example: $A1, or A$1. 
 
Errors in Formulas 
 
When something prevents a formula from calculating, you will see an error message 
instead of a result. 
 
 
 
Error Values 
Error Meaning How to Fix 

#### 
The column is too narrow to 

display the result of calculation Widen the column 

#VALUE  
Wrong type of argument or 

reference 
Check operands and 

arguments 

#DIV/0! Data is attempting to divide by 
zero 

Change the value or the cell 
reference so that the formula 

doesn't divide by zero 
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#NAME? 
Formula is referencing an 

invalid name 
Be sure the name still exists or 

correct the misspelling 

#REF! 
Excel can't locate the 

referenced cells(for example, 
the cells were deleted) 

Click Undo to restore 
references and then change 

formula references 

#NULL 
Reference to intersection of 

two areas that do not intersect 
Check for typing and reference 

errors 

 
 
 
Excel Functions Overview 
 
Statistical Functions Overview 
Statistical functions are among the most widely used functions in Excel. 
 
 
FUNCTION WHAT IT DOES 
AVERAGE(range) Calculates the mean (arithmetic average) of a range of cells 

COUNT(range) Counts the number of values (cells containing numbers in a range) 

COUNTIF(range, 
value) 

Counts the number of cells that are the same as a specified value. 

MAX(range) Returns the maximum value of a data set. 

MIN(range) Returns the minimum value of a data set. 

MODE(range) Returns the most frequently occurring, or repetitive, value in a 
range of data. 

STDEV(range) Calculates the standard deviation of a sample or an entire deviation. 

 
Where 
 
 range _ Represents the set of values (number1, number2…) 
 
 value _ The criteria upon which you want to evaluate; it can be a number (14), a cell 
reference (G5), an expression (E5>7), or text (“Victor”). 
 
Math Functions Overview 
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Math functions in Excel can be used to perform calculations as stand-alone functions or 
combined to create complex formulas. Excel has a great number of Math functions but 
the most commonly used ones are: 
 
Ø Sum 
Ø Round 
Ø Ceiling 
Ø Floor 
 
You can use the Round ( ), Ceiling ( ), or Floor ( ) function to round a number to any 
number of digits you want. 
 
Sum Function  
 
§ Adds the numbers in a range or multiple ranges of cells. 
§ Written as: 

Sum (number1, number2…)  
Where  
Number _ The NUMBER arguments are 1 to 30 arguments for which you 
want the total value or sum. 

Number1 is written as a number, a reference to a cell, or to a range of cells. 
        
Round Function 
        

§ Rounds a number to a specified number of digits.  
§ Written as: 

Round (number, num_digits) 
 
Where 

• Number _ The value you want to round. 
• Num_digits _ The number of decimal places you want to round. 

     
     Ceiling Function 
             

§ Returns number rounded up, away from zero, to the nearest multiple you 
specify.  

§ Written as: 
Ceiling (number, significance) 
 
Where 

• Number _ The value you want to round  
• Significance _ The multiple you want to round to 
 

     Floor Function 
 

§ Rounds number down, toward zero, to the nearest multiple you specify. 
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§ Written as: 
Floor (number, significance) 
 
Where 

• Number _ The value you want to round. 
• Significance _ The multiple you want to round to 

 
Information Functions Overview 
Information functions are generally made up of logical results and can be used in many 
business situations. Combined with other functions, the information functions can 
manage lists of data and provide feedback based on a logical result. The only function 
that could be useful for you is: 
 
      IsNumber ( ) Function 
 

§ Returns true if the value is a number. 
§ Written as: 

ISNUMBER (value) 
 

   Where 
                Value _ this is the cell or range you want tested. 
 
Overview of Logical Functions  
Logical functions test cells & ranges and can return only: True or False.  
Commonly used logical functions are: 
Ø AND 
Ø OR 
Ø NOT 
Ø IF  

 
AND Function  
 
§ Returns true if all the logical arguments are True. 
§ Returns False if one or more arguments is False. 
  
§ Written as: 

AND (logical1, logical2 …) 
 
Where 
Logical Value 1, 2 … _ The test results in a logical TRUE or FALSE return. Up 
to 30 conditions can be tested together. 

 
OR Function 
 
§ Returns False if all the logical arguments are False 
§ Returns True if  one or more arguments is True  
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§ Written as: 

OR (logical1, logical2…) 
 
Where  
Logical Value 1, 2 … _ These are the conditions to be met to test a logical true or 
false result. You can use up to 30 conditions within the formula. 
 

NOT Function  
 

§ Returns the opposite of the logical va lue 
 

§ Written as: 
NOT (logical) 
 
Where 
Logical _ This is the value that can be evaluated with a True or False Condition. 
If True, NOT returns False, if False, NOT returns True. 

 
IF ( ) Function  
 
§ The IF ( ) function decides the contents of a cell on a spreadsheet based on whether 

a test condition is true or false. 
§ It returns a value if one condition is TRUE, and returns another value or result if the 

condition is FALSE. 
  
§ Written as: 

IF (logical_test, value_if_ true, value_if_false) 
 
Where 

§ Logical_test _ Is any value or expression that can be evaluated to True or False. 
§ VALUE IF TRUE _ Is the value returned if the logical_test is True. 
§ VALUE IF FALSE _ Is the value returned if the logical_test is False 

 
  The operators in the logical_test of the IF function may be: 
     
              =    Equal to  
              <> Not equal to 
              > Greater than 
              >= Greater than or equal to  
              < Less than 
              <= Less than or equal to  
             
  In addition to that, the logical_test of an IF function can contain other logical functions   
  like AND, OR, NOT, and other functions supported by Excel. 
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Nested IF ( ) Function  
If you wish to test more than one condition, you can nest an if () function within another 
if () function: 

Written as:: 

=if (logical_test, result_if_true, if (logical_test, result_if_true, if (logical_test, 
result_if_true, result if false)) 

Example: If (I am married, If (I get a child, I will send him/her to AUB)). 

Additional Readings 
Financial Functions Overview 
Microsoft Excel contains excellent financial functions you can use to perform useful 
calculations, such as projecting the future value of investment or figuring the monthly 
loan payments. You can also use these functions to help you analyze your upcoming 
financial functions. 
 
Commonly Used Functions 
 
Some of the more common Financial Functions used are: 
 
Ø Future Worth (FV) 
Ø Annual Payment (PMT) 
Ø Present Value (PV) 
 
 

Future Worth (FV) 
 
§ Returns the future value of an investment based on periodic, constant payments 

and a constant interest rate. 
 
§ Written as: 

FV (rate, nper, pmt, pv, type) 
 
Where  

• Rate  _ The interest rate per period 
• Nper _ The number of payment periods in an annuity 
• Pmt – The payment made per period. Typically containing principal and 

interest and does not change over the life of the loan. 
• Pv _ The present value that a series of payments is worth right now. If 

omitted, Excel assumes zero. 
•  Type _ The timing of the payment. When the payments are due. 

 
Annual Payment (PMT) 
 
§ Calculates the loan payment for a loan based on constant payments and constant 

interest rates. 
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§ Written as: 

PMT (rate, nper, pv, fv, type) 
 
Where 

• Rate _ The interest rate of the loan. 
• Nper _ The number of total payments. 
• Pv _ The present value or the principal amount. 
• Fv _ The future value or cash balance you want to attain upon the last 

payment _ for a loan it would be zero. 
• Type _ The payment timing _ when the payments are due. 
 

Present Value (Pv)  
§ Returns the present value based on an investment. 

 
§ Written as: 

      PV (rate, nper, pmt, fv, type) 
       

Where 
§ Rate _ The interest rate of the loan. 
§ Nper _ The number of total payments 
§ Pmt _ The payment made each period. It must contain constant. Typically, 

it includes the principal and interest. 
§ Fv _ The future value or cash balance you want to attain upon the last 

payment. For a loan it would be zero. For a future amount you want to 
attain with payments, it would be the total goal amount. 

§ Type _ The payment timing _ when the payments are due. 
                     
 
Text to Speech 
 
To hear the text in your worksheet: 
1- Insert the “Text to Speech” toolbar. Go to: View > Toolbars > Text to Speech 

 
2- Highlight the cells you want to convert to speech 

3- Press on speak cells button  of the “Text to Speech” toolbar 
 
Tab Color 

To change the tab color . Right click on the tab you 
want, and select “Tab Color”. From the color list that appears choose the color you want. 
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Hide / Unhide 
To hide a column or a row, you have to highlight the whole column / row by right 
clicking on its Letter/ Number, and choose Hide. 
To unhide a column or a row, highlight the columns / rows next to the hidden one, right 
click on them, and choose unhide. 
 
 

o This tutorial is one out of three tutorials on MS Excel 2002. You can visit 
http://webfaculty.aub.edu.lb/~acc/Resources/Tutorials/excel/excel.htm     
to view them. 

o for more information about “Academic Computing Center” , and 
workshops schedule, please visit our web site:  
http://webfaculty.aub.edu.lb/~acc/Workshops/workshops.htm 
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